Intel® System Event Log (SEL) Viewer Utility

User Guide

Document No. E12461-007
Legal Statements

INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH INTEL® PRODUCTS FOR THE GENERAL PURPOSE OF SUPPORTING INTEL DEVELOPED SERVER BOARDS AND SYSTEMS. NO LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS IS GRANTED BY THIS DOCUMENT. EXCEPT AS PROVIDED IN INTEL’S TERMS AND CONDITIONS OF SALE FOR SUCH PRODUCTS, INTEL ASSUMES NO LIABILITY WHATSOEVER, AND INTEL DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF INTEL PRODUCTS INCLUDING LIABILITY OR WARRANTIES RELATING TO FITNESS FOR A PARTICULAR GENERAL PURPOSE, MERCHANTABILITY, OR INFRINGEMENT OF ANY PATENT, COPYRIGHT OR OTHER INTELLECTUAL PROPERTY RIGHT.

UNLESS OTHERWISE AGREED IN WRITING BY INTEL, THE INTEL PRODUCTS ARE NOT DESIGNED NOR INTENDED FOR ANY APPLICATION IN WHICH THE FAILURE OF THE INTEL PRODUCT COULD CREATE A SITUATION WHERE PERSONAL INJURY OR DEATH MAY OCCUR.

Intel may make changes to specifications and product descriptions at any time, without notice. Designers must not rely on the absence or characteristics of any features or instructions marked "reserved" or "undefined." Intel reserves these for future definition and shall have no responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The information here is subject to change without notice. Do not finalize a design with this information.

The products described in this document may contain design defects or errors known as errata which may cause the product to deviate from published specifications. Current characterized errata are available on request. Contact your local Intel sales office or your distributor to obtain the latest specifications and before placing your product order.

Intel® Active Management Technology requires the computer system to have an Intel AMT-enabled chipset, network hardware and software, as well as connection with a power source and a corporate network connection. With regard to notebooks, Intel AMT may not be available or certain capabilities may be limited over a host OS-based VPN or when connecting wirelessly, on battery power, sleeping, hibernating or powered off. For more information, see http://www.intel.com/technology/manage/iamt/

Any software source code reprinted in this document is furnished under a software license and may only be used or copied in accordance with the terms of that license. Refer to the license corresponding to the software component provided in the toolkit for details. Portions of this toolkit may be supplied under Open Source License agreements.

Intel, Intel Core, and Xeon are trademarks of Intel Corporation in the U.S. and other countries.

* Other names and brands may be claimed as the property of others.

Copyright © 2006–2009 Intel Corporation. All rights reserved.
## Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>May 2007</td>
<td>-001</td>
<td>Initial release.</td>
</tr>
<tr>
<td>September 2007</td>
<td>-002</td>
<td>Updated to include the Intel® Server Board X38MLST.</td>
</tr>
<tr>
<td>September 2007</td>
<td>-003</td>
<td>Updated to add Intel® Server Board S3200SH.</td>
</tr>
<tr>
<td>September 2007</td>
<td>-004</td>
<td>Updated to add Intel® Server Board S5400SF</td>
</tr>
<tr>
<td>November 2008</td>
<td>-005</td>
<td>Updated to add Intel® Server Board S5500/S5520 Series</td>
</tr>
<tr>
<td>July 2009</td>
<td>-006</td>
<td>Updated to add Intel® Server Board S3420GP</td>
</tr>
<tr>
<td>November 2009</td>
<td>-007</td>
<td>Updated support OS information and added <em>Note</em> on Utility having different version/build number for different platforms</td>
</tr>
</tbody>
</table>
About this Manual

Thank you for purchasing and using Intel® Server Boards. This version of the utility supports Intel® Server Boards S7000FC4UR, X38MLST, S5400SF, S3200SH, S5500/S5520, and S3420GP.

This manual is written for system technicians who are responsible for troubleshooting, upgrading, and repairing this server board. The System Event Log (SEL) Viewer is used to display, clear, or save the SEL log on your server. For the latest information on your server, refer to http://support.intel.com/support/motherboards/server/.

Manual Organization

- Chapter 1 - Introduction
- Chapter 2 - Using the Intel® SEL Viewer
- Appendix A - Exit Error Codes
Contents

1. Introduction .................................................................................................... 3

2. Using the Intel® SEL Viewer ......................................................................... 4

   2. Using the Intel® SEL Viewer ......................................................................... 4
      Installing the Intel® SEL Viewer......................................................................................4
      Launching the Intel® SEL Viewer ........................................................................................5
      Viewing SEL records in Interpreted Text Format .............................................................6
      Viewing SEL records in Hex Format .......................................................................................9
      Viewing the Intel® SEL Viewer Information window ........................................................12
      Navigating the Intel® SEL Viewer window ........................................................................12
      Saving the Intel® SEL to a file ..............................................................................................13
      Viewing the Intel® SEL from a file ........................................................................................13
      Checking Intel® SEL properties (number of entries, add/erase time, and space available) .14
      Clearing the Intel® SEL ........................................................................................................14
      Sorting the Intel® SEL entries in the UI ................................................................................14
      Go To Option (Linux* – Only Feature) ..................................................................................15
      Getting additional help .........................................................................................................15
      Uninstalling Intel® SEL Viewer .............................................................................................16

Appendix A. Exit Error Codes .............................................................................. 17

Figures

Figure 1. Error displayed if no driver present (WinPE*) ..............................................4
Figure 2: SEL Viewer Text View ...................................................................................6
Figure 3: SEL Viewer Main Utility Window (Win PE*) ..................................................7
Figure 4: SEL Viewer Main Window (Linux*) .................................................................8
Figure 5: SEL log in Hex Format ...................................................................................9
Figure 6: SEL Records in Hex Format (Win PE*) ..........................................................10
Figure 7: SEL Records in Hex Format (Linux*) ...............................................................11
Figure 8: Status Box .......................................................................................................12
Figure 9: SEL Properties Dialog ....................................................................................14
1. Introduction

The Baseboard Management Controller (BMC) records details about the system events in a log in flash memory. Each SEL entry is a single system event.

The SEL Viewer utility provides the ability to view system event records stored on the server management storage device of a server. The utility displays the SEL records in either a text or a hexadecimal format. The utility also allows you to save SEL entries to a file and load SEL entries from a file for viewing. You can also reload SEL entries from a server and see properties of SEL entries. The SEL entries can be viewed in two modes: interpreted text mode and hex mode.

This version of the SEL Viewer utility runs on the target servers in the Extensible Firmware Interface (EFI) v1.1 and v2.0 shell, Windows* Server 2003 Enterprise (32bit & EM64T), Windows* Server 2008 Enterprise (32bit & EM64T), Windows* XP SP3 (32 bit), Windows PE * 2004 (1.5) - Built from Windows XP* Professional with Service Pack 2 (SP2), Windows PE* 2005 (1.6) - Built from Windows* Server 2003 with Service Pack 1 (SP1), Windows PE* 2.0 - built from Windows Vista, 32 bit, Windows PE* 2.1 - built from Windows Vista* SP1 or Windows* Server 2008, EM64T, Windows Vista SP1 (32 bit & EM64T), RHEL5 Update 3 (32 bit & EM64T) and SLES11 (32 bit & EM64T).

**Note**: SELViewer version may be different across different platforms. Please download the supported SELViewer version and build under your platform of supported web site. Also please refer to release notes for known issues.
2. Using the Intel® SEL Viewer

Installing the Intel® SEL Viewer

To install the SEL Viewer Utility in EFI, do the following:

1. Copy all the files in the SEL Viewer release directory for EFI to a USB flash drive, or create an EFI-bootable CD.
2. Insert the removable media into the server.
3. Boot the server and press the F2 key when prompted to enter BIOS setup.
4. Go to the Boot Manager menu and select the option to boot to EFI shell.
5. At the EFI shell prompt, type fsn:, where n is the file system number corresponding to the device that contains the SEL Viewer utility files.

To install the SEL Viewer Utility in Windows® with the standalone installation, do the following:

1. Copy all files and subdirectories from the utility released location into a folder on the hard drive. (for example, c:\selviewer)
2. Open a command prompt and change to that directory (for example, cd c:\selviewer\imbdriver).
3. Execute "install.cmd <full-path>" specifying the full path of the folder in which files were copied (for example, "install c:\selviewer\imbdriver").
4. This install script will install the imbdrv.sys driver.
5. To run the SEL Viewer Utility, open a command prompt, and change directory to the folder in which the selview.exe file resides (for example, cd c:\selviewer).

You can now run the utility.

Note: If the driver is not installed Utility displays an error as shown below

![Error](image.png)

Figure 1. Error displayed if no driver present (WinPE*)
To install the SEL Viewer Utility in Linux*

- **Pre requisites**
  
  Java* Runtime Environment (JRE) must be installed.

  XServer must be running for the Intel® SEL Viewer GUI to work.

1. Copy all files and subdirectories from the utility released location into a folder on the hard drive. (for example, /home/selviewer)
2. Open a command prompt and change to that directory (for example, cd /home/selviewer).
3. Run Selview

You can now run the utility.

---

**Launching the Intel® SEL Viewer**

To launch the SEL Viewer, do the following:

1. Boot to target OS.
   
   From the directory containing the SEL viewer files, launch the SEL viewer from the EFI shell using the following syntax:

   ```
   selview [/clear | {/save [filename] [/hex]} | /h | /?]
   ```

   **Note:** a hyphen (-) may be substituted for the forward slash (/).

   Examples:

   ```
   selview
   ```
   (This launches the graphical version of the SEL viewer.)

   ```
   selview /clear
   ```

   ```
   selview /save MyFileName /hex
   ```

   ```
   selview /h
   ```
Viewing SEL records in Interpreted Text Format

1. Launch the SEL Viewer.
2. The graphical display will display all the SEL entries. The following example shows the text view.

![Figure 2: SEL Viewer Text View](image)

Use arrow keys and <Enter> to select from menu.
The EFI based SEL Viewer’s main window is based on a multi-column display pane as shown in Figure 3. It displays all the SEL records and a pull-down menu used for selecting the main functions available in the utility.
See Figure 4 for SEL Viewer Main Utility Window (Linux*). The default format in which information is displayed in interactive mode is the interpreted text format.

<table>
<thead>
<tr>
<th>Serial No.</th>
<th>Time Stamp</th>
<th>Sensor Type &amp; Number</th>
<th>Event Description</th>
<th>Generator ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001</td>
<td>2008/04/25-12:05:21</td>
<td>Fan / System Fan 2 (#0xD1)</td>
<td>Informational event: System Fan 2 reports the sensor is no longer in a critically low state. Sensor reading</td>
<td>BMC - LLN #0 (Channel #00h)</td>
</tr>
<tr>
<td>0002</td>
<td>2008/04/25-12:05:21</td>
<td>Fan / System Fan 2 (#0xD1)</td>
<td>Informational event: System Fan 2 reports the sensor is no longer in a critically low state. Sensor reading</td>
<td>BMC - LLN #0 (Channel #00h)</td>
</tr>
<tr>
<td>0003</td>
<td>2008/04/25-12:05:24</td>
<td>OS Critical Stop #0x00</td>
<td>CRITICAL event: System Manager Service STOP</td>
<td>BMC - LLN #0 (Channel #00h)</td>
</tr>
<tr>
<td>0004</td>
<td>2008/04/25-12:05:24</td>
<td>OEM data not defined.</td>
<td>OEM system event record (Rec...)</td>
<td>OEM data not defined.</td>
</tr>
<tr>
<td>0005</td>
<td>2008/04/25-12:05:24</td>
<td>OEM data not defined.</td>
<td>OEM system event record (Rec...)</td>
<td>OEM data not defined.</td>
</tr>
<tr>
<td>0006</td>
<td>2008/04/25-12:05:24</td>
<td>System Event #0x83</td>
<td>Informational event: System Ev.</td>
<td>BIOS (Channel #00h)</td>
</tr>
<tr>
<td>0007</td>
<td>2008/04/25-12:05:24</td>
<td>System Event #0x83</td>
<td>Informational event: System Ev.</td>
<td>BIOS (Channel #00h)</td>
</tr>
<tr>
<td>0008</td>
<td>2008/04/25-12:05:24</td>
<td>Power Unit / Power Unit (#0x11)</td>
<td>Informational event: Power Unit</td>
<td>BMC - LLN #0 (Channel #00h)</td>
</tr>
<tr>
<td>0009</td>
<td>2008/04/25-12:05:24</td>
<td>Power Unit / Power Unit (#0x11)</td>
<td>Informational event: Power Unit</td>
<td>BMC - LLN #0 (Channel #00h)</td>
</tr>
</tbody>
</table>

Figure 4: SEL Viewer Main Window (Linux*)

The interpreted data is displayed in several columns as follows:

- Serial number of the system events being displayed. Starting with 1, and increasing by one for each event. The title of this column is “Num”.
- Time Stamp.
- Sensor Type and Number.
- Event Description
- Generator ID.

The bottom information pane shows the details on the highlighted SEL entry. Use the arrow keys to move up and down, or the Tab key to highlight a menu. In Linux*, the bottom information pane contains a statistics panel which holds a statistical table of events based on their Event Type (Critical, Warning, Informational and Others).

---

1 Based on the IPMI Specification, BIOS EPS
For information on using the menu items see section Viewing the Intel® SEL Viewer Information window.

**Viewing SEL records in Hex Format**

Use the **View** menu to choose how the SEL entries are displayed (raw hexadecimal format or plain text). Select the raw-hexadecimal format to view the SEL records in HEX format.

The following screen shows an example of the SEL log in Hex format.

![SEL log in Hex Format](image)

Use arrow keys and <Enter> to select from menu.

Figure 5: SEL log in Hex Format
The following figure shows SEL records in hex format (Win PE*):

![Figure 6: SEL Records in Hex Format (Win PE*)](image)

Figure 6: SEL Records in Hex Format (Win PE*)
The following figure shows SEL records in Hex format (Linux*):

![Image of SEL Viewer Utility](image)

**Figure 7: SEL Records in Hex Format (Linux*)**

The abbreviations used in the raw Hex display are as shown in the following table:

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RID</td>
<td>Record ID</td>
</tr>
<tr>
<td>RT</td>
<td>Record Type</td>
</tr>
<tr>
<td>TS</td>
<td>Time Stamp</td>
</tr>
<tr>
<td>GID</td>
<td>Generator ID</td>
</tr>
<tr>
<td>ER</td>
<td>Event Message Format Revision</td>
</tr>
<tr>
<td>ST</td>
<td>Sensor Type</td>
</tr>
<tr>
<td>SN</td>
<td>Sensor Number</td>
</tr>
<tr>
<td>EDIR</td>
<td>Event Dir and Event Type</td>
</tr>
<tr>
<td>ED1, ED2, ED3</td>
<td>Event Data</td>
</tr>
<tr>
<td>MID</td>
<td>Manufacturer ID</td>
</tr>
<tr>
<td>OEM</td>
<td>OEM Defined</td>
</tr>
</tbody>
</table>
Viewing the Intel® SEL Viewer Information window

This option allows you to view/hide the SEL Information window. When you run utility, by default, the SEL Info window is visible and the sub-menu is shown as “Hide SEL Info Window”. If you select “Hide SEL Info Window”, the SEL Info window is removed from the display area and the sub-menu text changes to “View SEL Info Window”. The user can again add the SEL Info window using this sub-menu. Hide SEL Info Window/View SEL Info Window option is currently disabled in Hex view of EFI based SEL Viewer utility. SEL Info window automatically goes off when change from text view to hex view. In case of Linux*, this option is available under the SEL Menu item.

Navigating the Intel® SEL Viewer window

To navigate the SEL Viewer window, from the pull-down menu, use the arrow keys to move around the various menu items and the <Enter> key to select a particular menu item. Also for WinPE* based SEL Viewer Utility use <Alt> key to select the menu and use arrow keys to move around various menu items and <Enter> key to select a particular menu item. Also in WinPE* based SEL Viewer utility use <Alt-F> to open file menu item, <Alt-S> to open SEL menu, <Alt-V> to open view menu, <Alt-H> to open Help menu. In case of WinPE* based SEL Viewer utility menu item can be accessed by left clicking the mouse on a menu item in case of WinPE* based SEL Viewer Utility. A brief help message about the option selected from the menu is displayed in the tip-view window, which is displayed at the bottom of the main window for EFI based SEL Viewer Utility. This feature is not supported in WinPE* based SEL Viewer Utility. For EFI based SEL Viewer Utility use <Tab> to move between the display pane, information window at the bottom and pull-down menu.

The display pane supports arrow keys, <PgDn>, <PgUp>, <Home>, and <End> keys to move across the display pane. In WinPE* based SEL Viewer utility <Home> key selects first record and <End> key selects last record. In case of EFI based SEL Viewer utility <HOME> key selects beginning of the selected SEL entry in the display pane, <END> key selects the end of the selected SEL entry in the display pane. EFI Based SEL Viewer Utility supports the <F5> key to move forward between columns and <F6> to move backwards. Use left arrow key to scroll to the left and right arrow key to scroll to right in display pane.

When the utility is first invoked, it loads the SEL records from non-volatile storage on the server. A status box as shown in Figure 8: Status Box is displayed to indicate that the SEL Viewer is loading SEL records from the server. In case of Linux*, the status message would be displayed on the status bar of the Utility main window.

![Figure 8: Status Box](image-url)
In Linux* SEL Viewer Utility, Serial Numbers can be color coded based on the severity of SEL Event. This feature is currently available only on Linux*. A small panel is provided on the bottom right corner which has a statistical view of the SEL Records. It contains the count of the SEL events segregated based on the severity type (that is, Informational, Warning, Critical, and Others). This feature is also currently available only on Linux*.

**Saving the Intel® SEL to a file**

You may want to save the SEL to a file for analysis, record keeping, or to documentation of a system issue. There are two ways to save the SEL to a file (the Windows Preboot Environment *version is shown in this example):

- To save the SEL, use the following command line syntax:
  
  In interpreted text format - `selview /save MyFileName`
  
  In hex format - `selview /save MyFileName /hex`

- Use the File | Save menu option from the graphical SEL viewer window.

  To save the SEL data to a file with a “.sel” file name extension, either in interpreted text format or in raw hex format, depending on the mode in which records are currently displayed.

**Viewing the Intel® SEL from a file**

To view the SEL records that you previously saved to a file, use the File | Open menu option from the graphical SEL viewer window.

To return to viewing the SEL records from non-volatile memory, use the SEL | Reload menu option.
Checking Intel® SEL properties (number of entries, add/erase time, and space available)

To check SEL properties in the SEL Properties dialog, use the SEL | Properties menu option from the graphical SEL viewer window.

![SEL Properties Dialog](image)

Notes:
- The SEL viewer will display the Free Space Remaining in bytes.
- In Linux*, the SEL Properties dialog will not display Last Add Time and Last Erase Time.

Clearing the Intel® SEL

The SEL has a limited capacity. Refer to the Specifications in your server board Product Guide for the maximum number of records for server. After the SEL is full, subsequent system events will not be recorded and you will need to manually clear the SEL. There are two ways to clear the SEL (the Windows Preboot Environment *version is shown in this example):

- Use the command line syntax: `selview /clear`
- Use the SEL | Clear menu option from the graphical SEL viewer window.

Sorting the Intel® SEL entries in the UI

Use the SEL | Sort by option in the SEL Viewer main window, to sort the SEL entries by different fields. This option, when selected, displays a list of fields by which the entries can be sorted. You can sort the records by Num, Time Stamp, Sensor Type and Number, Event Description and Generator ID. Upon choosing the appropriate field, sorting is done by that field. This option is not available if the SEL entries are displayed in hexadecimal mode. For WinPE*/Linux* based SEL Viewer Utility sorting can also be performed by clicking on the appropriate Column heading using a mouse (in case of text mode display).
Go To Option (Linux* – Only Feature)

Use the SEL | Go To option in the SEL Viewer main window to select a particular SEL entry given its Serial Number. User can enter the Serial Number of the SEL Entry in the textbox provided in the Go To dialog and the SEL Table on the Utility main window would be scrolled and that particular entry would be highlighted. Go To can be accessed by the shortcut CTRL+G. This feature is currently supported only on Linux*.

Getting additional help

If you need help on the command line syntax or any of the graphical menu items that are not described in this User Guide, use the online help. There are two ways to get help (the Windows Preboot Environment* version is shown in this example):

- Use the command line syntax: `selview /help`
- Use the Help menu option from the graphical SEL Viewer window.
Uninstalling Intel® SEL Viewer

To uninstall the SEL Viewer Utility in EFI, do the following:
1. Go to the directory in the command line prompt, where all your utility files are copied from the utility released location
2. Run ‘cd ..’ on a command line prompt. This will take you to a directory one level below.
3. Remove all the directories including subdirectories in the current directory where you are. This leads to the un-installation of the utility files.

To uninstall the SEL Viewer Utility in Windows*, do the following:
The utility files should be manually removed, if it was installed stand alone
1. Go to the directory in the command line prompt, where all your utility files are copied from the utility released location
2. Run ‘cd ..’ on a command line prompt. This will take you to a directory one level below.
3. Remove all the directories including subdirectories in the current directory where you are. This leads to the un-installation of the utility files.

To uninstall the SEL Viewer Utility in Linux*, do the following:
1. Go to the directory in the command line prompt, where all your utility files are copied from the utility released location
2. Run ‘cd ..’ on a command line prompt. This will take you to a directory one level below.
3. Remove all the directories including subdirectories in the current directory where you are. This leads to the un-installation of the utility files.
Appendix A. Exit Error Codes

The command line version of the SEL Viewer may be used in a script to automate the tasks of saving the SEL, clearing the SEL, or searching the SEL. The following list of exit codes may be useful in the error handling section of the script.

<table>
<thead>
<tr>
<th>Integer Value</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Successful termination</td>
</tr>
<tr>
<td>1</td>
<td>Unable to clear SEL</td>
</tr>
<tr>
<td>2</td>
<td>SEL log is empty</td>
</tr>
<tr>
<td>3</td>
<td>Unable to read SEL entries</td>
</tr>
<tr>
<td>4</td>
<td>Unable to create SEL file</td>
</tr>
<tr>
<td>5</td>
<td>Invalid invocation</td>
</tr>
<tr>
<td>6</td>
<td>IPMI Driver initialization failed</td>
</tr>
<tr>
<td>7</td>
<td>String file not found or unable to read string file</td>
</tr>
<tr>
<td>8</td>
<td>Unable to read string file</td>
</tr>
<tr>
<td>9</td>
<td>Unable to initialize SEL Viewer</td>
</tr>
<tr>
<td>10</td>
<td>Unknown error</td>
</tr>
</tbody>
</table>